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Product Overview
OnWeb Web-to-Host is a server-based Web application that publishes your existing legacy applications in
intranet, extranet, and Internet environments. It includes host display, printer, and file transfer features that
enable end users to work productively with host-based information in a familiar Windows or Web browser
environment. Web-to-Host provides access to a broad range of host types, including IBM mainframe, IBM
AS/400, DIGITAL VAX, UNIX, and HP systems.

System administrators can use the Session Configuration Manager tool to easily configure client sessions
that can be published to end users.

For more information on Micro Focus Solutions, visit the Micro Focus web site (http://www.microfocus.com).

Features
Designed for use in an intranet environment, the Pro component offers the richest feature set and consists
of ActiveX controls that give users access to mission-critical host applications and data. Pro provides these
client session types:

• Mainframe Display, Mainframe Printer
• AS/400 Display, AS/400 Printer, AS/400 File Transfer
• UNIX Display
• HP Display

Pro client sessions include these advanced features and options:

• Mainframe file transfer (can include SimXfer tables)
• AS/400 File Transfer
• AS/400 batch file transfers
• Macros
• Hotspots
• User profile enhancements
• Restricted user support
• An MSI packaging utility for automatically installing Pro components
• A distribution utility
• A download and install service
• VBA-type scripting
• Customizable menus and toolbars
• End-user keyboard mapping
• Administrator keyboard mapping
• Tracing

Hotspots, a word or set of characters on the host screen, activate a function when clicked. Using the
Hotspots Configuration dialog box, you can enable/disable, show/hide, create, and modify both default
and user-created hotspots. Default hotspots are host commands displayed on-screen. User created
hotspots are custom macros you assign to selected on-screen text. You can also use hotspots and macros
to log on to and run host applications automatically. Any protected text on your host screen can be turned
into a hotspot. In mainframe displays, you can also configure hotspots for non-protected text.

Pro AS/400 File Transfer moves files and data between the host and the PC using either the menu bar or
toolbar options of the AS/400 display. A customized toolbar button activates a pre-configured FTX file and
starts the AS/400 FTX application. A new AS/400 emulation type has been added to the Session
Configuration Manager. It opens the AS/400 FTX application and loads an existing FTX configuration on
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the client. Your users can customize the file transfer session, configuring options such as the data format
for sending and receiving, file locations, application behavior both during and upon completion of the
transfer, security settings, and host connection.

With enhanced user profiles, user configuration files (.cph) are no longer deleted automatically when
changes are made in the HTML files for configurable options. For more information, see User Profile
Configuration.

Pro ActiveX components are downloaded to the client once, during the first login. A new download service
is first installed on the client workstation. Once the service is installed on the client, all users (including
restricted users) can work with the Pro ActiveX controls. The service handles all installs, upgrades, and
downloads of Pro ActiveX components.

The Web-to-Host Distribution Packager enables you to bundle multiple Web-to-Host configuration and data
files into a single, easily distributed package. Users can run sessions that include a complete work
environment with components such as pre-defined scripts, macros, hotspots, custom toolbars, background
images, icons, screen/font colors, AS/400 File Transfer and Batch File Transfer profiles. The Web-to-Host
Distribution Packager helps you provide standardized functionality and a single look and feel for all users.
For more information, see the online Help.

Architecture
The figure below shows how Web-to-Host works once the system administrator has created the host
sessions and published them to users. The following sections describe how this architecture is applied to
each of the component types.

The ActiveX objects are downloaded to the client the first time a user opens a session. When you install
updates on the server, they are downloaded automatically to the client the next time a user opens a
session. This architecture enables the client to communicate directly with the host, as shown in the figure
above.
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Security
Web-to-Host maintains persistent client-to-host sessions. It is important that users be aware of session
persistence in relation to information security, especially when sessions are configured to run inside a
browser window. In this mode, only one session is visible on the screen at a time, though other sessions
could be running in the background.

Users who have access to sensitive information on host systems should consider running each session in
a separate window to keep all concurrent sessions visible on the screen. Users can also ensure that all
connections are severed by closing their browser when they leave their work area. For details on
configuring sessions to run in a separate window, see Start options.

Web-to-Host supports:

• SSL (Secure Socket Layer) for IBM mainframe, AS/400, and UNIX hosts.
• SSH (Secure Shell) for Pro UNIX display.
• Kerberos authentication for AS/400.

With this security support, users can securely access applications and transfer data between their
desktops and mainframe, AS/400, and UNIX systems, encrypting the session data stream to a host
capable of supporting these protocols.

Finding information
Web-to-Host product documentation includes:

• This Administrator Guide, which explains how to install, uninstall, configure, and deploy the product.
• The Readme file, which contains information about new features, late-breaking changes, and known

issues.

The Help page of the Session Configuration Manager contains links to the Readme file and this
Administrator Guide.

• Context-sensitive Help for the Session Configuration Manager, a tool for configuring Pro client sessions.

• User guide for Pro client. This Help for end users explains how to configure and run features and
options in the client session.
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Server Installation
Installing Web-to-Host Server on a Windows platform

Note: Web-to-Host Server can be deployed only on a 64-bit Windows platform.

1. Either activate Internet Information Server (IIS), or install any other Web Server.
2. Install Web-to-Host Server under the root directory of an installed Web server.
3. Run the Session Configuration Manager to create and configure (or migrate) session profiles.
4. Publish session profiles to clients.

Web-to-Host files are installed into a w2hlegacy directory (created during installation) that must reside
under the root, or in the subfolder of the root directory of the installed Web server.

Installing Web-to-Host Server on a non-Windows platform

1. Install Web-to-Host Server to any place on any machine. Web-to-Host files are installed into a
w2hlegacy directory (created during installation).

2. Install or run a Web server on the target non-Windows platform.
3. Copy the w2hlegacy directory to any location under the root directory of the Web server running on

the target non-Windows platform.
4. Run the Session Configuration Manager to create and configure (or migrate) session profiles.
5. Publish session profiles to clients.

Installing
Web-to-Host Server setup exists in four variants show below in increasing features set order:

Web-to-HostSetup.msi - standard setup.

Web-to-HostSetup-RDE.msi - RDE-enabled setup.

Web-to-HostSetup-Citrix.msi - Citrix-enabled setup.

Web-to-HostSetup-Eval.msi - fully featured 30 days evaluation setup.

Installing on a Web server running Windows

Using Setup

1. Run one of the appropriate MSIs listed above. 

This installs a default instance of Web-to-Host Server (see the next section about installing multiple
instances).

2. Click Next in the Welcome dialog.

3. Read the End-User License Agreement, select the option to accept it, then click Next.

4. Specify the Web Server Root directory (this can be the root publishing directory of your Web server or
any subdirectory under the Web root), then click OK.

5. To install to a subdirectory, select Enable subdirectory support, then type the path in the box
provided.

6. The setup program creates a new w2hlegacy directory in either the specified Web Server Root
directory or in its subfolder, which is specified by the path under Enable subdirectory support.
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7. When setup finishes, click Finish button to exit.

Using the command line
Web-to-Host Server Setup allows you to install up to five instances side-by-side using command line
options in addition to the default instance. In addition, for any instance of Web-to-Host Server, both the
Web Root directory and Web Root subdirectory can be specified in the command line.

Installing a default instance

To install a default instance, run the following command. Square brackets [ ] enclose optional attributes and
angle brackets <> enclose parameters values.

msiexec /i <full_path_to_msi> [INSTALLDIR=<Web_Root_directory_path>]
[ENABLE_WEB_SUBDIR=1 WEB_SUBDIR=<Web_Root_directory_path>]

Values containing spaces must be enclosed in quotation marks ("). For example:

INSTALLDIR="C:\Program Files\wwwroot"

Example:

msiexec /i C:\temp\Web-to-HostSetup.msi INSTALLDIR=C:\inetpub\wwwroot
ENABLE_WEB_SUBDIR=1 WEB_SUBDIR=w2hServer

Installing a non-default instance

Web-to-Host Server Setup multi-instance functionality allows to install up to five instances of the same
Web-to-Host Server version on the same machine.

The difference between the instances is up to you. For exmple, you might want different fixes to be applied
to different instances, or you might want to install particular instances outside the Web Root directory as
templates to be used later on a variety of other operating systems on other machines.

To install a non-default instance, two mandatory command line options are necessary in addition the
optional ones in the command line above (the pipe sign | denotes mutually exclusive values):

msiexec /i <full_path_to_msi> MSINEWINSTANCE=1 TRANSFORMS=":_<1|2|3|4|5>"
[INSTALLDIR=<Web_Root_directory_path>] [ENABLE_WEB_SUBDIR=1
WEB_SUBDIR=<Web_Root_directory_path>]

Here, TRANSFORMS must have one of the values ":_1", ":_2" and so on, which can be arbitrarily picked
from the five values allowed.

Values containing spaces must be enclosed in quotation marks ("). For example:

WEB_SUBDIR="w2h Server"

Example:

msiexec /i C:\temp\Web-to-HostSetup.msi MSINEWINSTANCE=1 TRANSFORMS=":_5"
INSTALLDIR=C:\inetpub\wwwroot ENABLE_WEB_SUBDIR=1 WEB_SUBDIR="w2h Server"

Any attempt to install the same instance twice would cause an error message.

Installing by copying
1. According to the instructions in the sections above, install a Web-to-Host Server instance - the default,

or otherwise - into the instance parent folder on a Windows machine, regardless of the Web server on
that machine.

2. Install and activate a Web server on the target machine, which can run any operating system - Windows
or otherwise.

3. On the target machine, prepare the Web-to-Host Server location. 
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If you decide to set up Web-to-Host Server in the Web Root subdirectory, create the subdirectory.

4. Copy the w2hlegacy folder from the instance parent folder on the Windows machine to Web-to-Host
Server location on the target machine.

Session Configuration Manager
After installing Web-to-Host on your Web server, the next task is to use the Session Configuration Manager
to create, edit, and migrate client profiles.

1. To run the Session Configuration Manager for Web-to-Host Server instance, which is installed by
running a .msi file, from the Windows Start menu, select All Programs > Micro Focus > Micro
Focus OnWeb 6.9.4.

2. To run the Session Configuration Manager for the Web-to-Host Server instance installed by copying,
navigate to the following address with your browser: http://<Web-to-Host-Server-location>/w2hlegacy/
config/hostwizard. 

For example:

http://localhost/w2h6.9.4/w2hlegacy/config/hostwizard/

Uninstalling
When removing Web-to-Host Server, you should also uninstall the Web-to-Host Pro Client from any client
machines it might have been installed on. See Client uninstall.

Uninstalling Web-to-Host Server instance installed
by .msi
1. Select Control Panel > Programs and Features.
2. Select Micro Focus OnWeb Web-to-Host Server6.9.4, then click Uninstall.

Uninstalling Web-to-Host Server instance installed by
copying
Remove the w2hlegacy folder from the Web-to-Host Server location on the target machine
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Creating and Migrating Client Profiles
After installing Web-to-Host on your Web server, the next task is to create or migrate client profiles. You
may also want to edit client profiles to configure new options, such as security, distribution packages, Pro
toolbars and menus, and Pro watermarks.

This chapter explains how to use the Session Configuration Manager to create, edit, and migrate client
profiles and how to deploy client profiles to your users.

Migrating client profiles from a previous version
After updating Web-to-Host product by installing a new version or upgrade, you must migrate all session
profiles created in the previous version by running the Session Configuration Manager in server mode. If
you do not update the session profiles, Pro client sessions do not open. An error message appears,
prompting you to contact your system administrator.

For details on running the Session Configuration Manager in server mode, see Creating client profiles.

Migrating profiles after upgrading
1. Run the Session Configuration Manager on the server by typing the following in the address bar of your

browser:

http://<webserver_name>/<subdirectory>/w2hlegacy/config/hostwizard

2. Click the Convert tab.
3. Load sessions by clicking Load Session.
4. Click Convert

This ensures that your Web-to-Host installation incorporates the most recent version numbers in the
session HTML files. Once new software is downloaded to the client workstations, the version numbers on
client workstations and session files must match. If new parameters exist in the current product version that
were not defined in the migrated profile, Web-to-Host uses the default values.

When the user opens a migrated profile, the browser displays a standard security dialog box asking if the
user wants to install and run software from Micro Focus. Administrators should tell their users to click Yes.

Running the Conversion Utility
1. Click the Convert tab.
2. Click Load Sessions to load Web-to-Host HTML sessions from previous versions.
3. Click Convert.

A result is shown for each file. If the conversion is successful, the converted file is added to a .zip file
which is downloaded to your computer.

4. At the end of the conversion process, a .zip file containing the converted sessions will be downloaded
to your computer.

Creating client profiles
This section describes how to use the Session Configuration Manager to create a new Web-to-Host client
session for your users. The Session Configuration Manager utility saves your client configuration settings in
an HTML file that invokes a named Web-to-Host client session.
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To run the Session Configuration Manager for Web-to-Host Server instance installed by running a .msi,
from the Windows Start menu, select All Programs > Micro Focus > Micro Focus OnWeb 6.9.4.

To run the Session Configuration Manager for a Web-to-Host Server instance installed by copying, navigate
to the following address with your browser: http://<Web-to-Host-Server-location>/w2hlegacy/config/
hostwizard.

For example:

http://localhost/w2h6.9.4/w2hlegacy/config/hostwizard/

Creating or editing a client profile
To use the Session Configuration Manager to create or edit client profiles:

1. Run the Session Configuration Manager on the server or on your local workstation.

2. Optional: For general instructions on using the Session Configuration Manager, click the Help icon at
the top right of the screen. This menu also contains links to the Readme file and this Administrator
Guide.

3. Click the Create tab, then do one of the following as needed:

• Create a new session. Select the session type, then click Create.
• Edit an existing session. Under Open an Existing Session, click Open, then specify the full path of

the HTML session configuration file to edit. The Browse utility defaults to the location of the last
saved configuration file.

The tabs for the selected host type appear.

4. Optional: Click each tab, click ? at each section, then print the help pages for each tab.

5. Configure the settings on each page as needed:

• For details on each field, see the online help. For details on configuring client start options,
concurrent sessions, and multiple language support, see Configuring client profiles.

• The Session Configuration Manager displays an asterisk next to required settings, and provides
many default settings. You need to enter only a few unique settings to make your connections work
correctly. However, you should check each page to be sure you select the appropriate options for
your needs.

6. To save the profile, click Create the bottom of the Session Configuration Manager. 

Web-to-Host generates the HTML file and instructs the browser to download the file to your computer.

The browser prompts you for the download location.

7. Specify an appropriate folder in which to save the profile. 

You must save the profile in a Web-published folder. Otherwise, client sessions do not receive automatic
updates from the Web server.

Configuring client profiles
This section describes some of the common options you can configure when creating or editing client
profiles in the Session Configuration Manager. For a list of options related to each technology, see the
Session Configuration Manager Help .

Start options
The following options are located on the Session Options page when creating or editing client profiles in
the Session Configuration Manager:

Run in a Separate Window
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This option applies to Pro display profiles.

The Run in a Separate Window option opens the client session in a separate browser
window.

You can also use this option to configure a Pro display profile to launch multiple standalone
sessions using the same configured connection. For details, see Multiple sessions.

The default is Clear. The host session runs inside the browser.

Server URL
With this option, you have the ability to run sessions from a web server other than the
default Web-to-Host server. The URL you enter indicates the location of the alternate Web-
to-Host server.

Enable Local Start

The Enable Local Start option allows users to run host sessions when the web server is
unavailable. With this option, whenever the user opens a client profile stored on the web
server, Web-to-Host copies that profile to the client workstation. The profile resides on the
web server as an HTML file that is named after the client session:

%LOCALAPPDATA%\Micro Focus\Rumba\LocalStart

It is best to run client profiles from the server to ensure that users have the most up-to-date
configuration and software.

When running Local Start profiles, help files are only available if, during configuration, the
administrator selected Install User Guide locally. Auto macro files and keyboard map files
configured by the administrator are cached on the client workstation when the session is
downloaded from the server, so these local copies are accessible to the client session
when the originating server is down. By default, Local Start is not selected.

Multiple sessions
Users can run concurrent Web-to-Host sessions and switch between session windows to perform tasks.
How users initiate multiple sessions and navigate between them depends on how you configure the
session profiles. There are three scenarios:

• Multiple sessions running in separate browser windows

By default, users must open multiple instances of the browser to start multiple client sessions. Users
can run concurrent host sessions and switch between sessions by clicking each browser window in
turn.

• Multiple sessions running outside the browser

Administrators can configure Pro display profiles to run in a separate window outside the browser (see 
Start options). The user must open a new instance of the browser to launch another host connection
but, once the new session is connected to the host, the browser can be closed without losing the
connection.

• Multiple Pro standalone sessions

Administrators can configure a Pro display profile to launch multiple standalone sessions using the
same configured connection. For example, a user can run two or more MyRumbaHost sessions, each in
its own window.

With this configuration, a new session opens in a separate window outside the browser whenever the
user accesses a session URL through the browser window. After launching one or more session
windows, users can close the browser without losing the host connection.

Configuring multiple Pro standalone sessions:

1. Create or edit or the Pro session profile in the Session Configuration Manager, then click the Session
Options tab.
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2. Check Run in a Separate Window and Allow Multiple Standalone Sessions.

When you enable these two options, users can launch a new session window using any method that
requests the session URL. For example, if your Web site includes a Pro display session called
Display.html, users can open multiple sessions by:

• Clicking a link on a Web page

If the Web page includes a link to http://<yoursite>/Display.html, users can click this link to
launch a new session window.

• Refreshing the browser with the session URL listed in the address bar

When the browser’s address bar contains the session URL, users can click the Refresh (or Reload)
button on the browser toolbar to launch a new session.

• Typing the address in the address bar

If users have browsed to another location after opening the session, they can enter the session URL in
the address bar to launch another session window.

• Recalling the address from history

If users cannot remember the URL, they can open the browser’s history list and then select the session
URL to launch a new session window.

Users can switch between sessions by clicking each of the windows in turn, or by using the taskbar. If the
browser closes, the session windows remain open.

International client sessions
When using the Session Configuration Manager to create or edit client profiles, configure the following
multi-lingual options to meet the language needs of your users:

You can set these options to use different languages if necessary. For example, you can set the user
interface to English and set the keyboard map and host character set to German.

Host Character Set
This option sets the host language (also known as the codepage). When configuring Pro and Java AS/400
and mainframe display or printer profiles, the option appears on the Connection page.

To specify the Host Character Set, select the language character set (or codepage) for the client session.
If the host uses a non-English (United States) language, select the language used by the host.

The host character set includes commonly used marks, accents, letters, and symbols of a specific
language. For example, if the host language is French, the host character set must also be French to
ensure that French special characters are transmitted to the host correctly and that the characters received
from the host display in the client session correctly.

The default setting is English (United States) - 37.

Keyboard mapping options
These options set the country or custom keyboard map for Pro display sessions.

Web-to-Host supplies numerous country keyboard maps to accommodate the special characters and
symbols used in various languages. You can deploy country keyboard maps in several ways. For example,
you can:

• Standardize all the sessions on one country keyboard.
• Base the keyboard map on the client workstation's regional settings.
• Enable the user to specify their own keyboard mappings.

When using the Session Configuration Manager to configure Pro AS/400, mainframe, UNIX, and HP
display profiles, the following options appear on the Keyboard Map page:
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Keyboard Map
You can select a standard country keyboard map or specify a custom keyboard map (.map
file) for the client session. For information on how to do this, see the Help. The default
keyboard map is U.S.A.

Custom Keyboard Map

The default is blank.

Note: To enable users to specify their own Pro keyboard map files, which
override the administrator-specified keyboard map, see the Session
Configuration Manager Help on the Client Options page when configuring
Pro display profiles.

Client Locale
This option sets the language of the Web-to-Host client user interface for display and printer sessions.

When using the Session Configuration Manager to create or edit any profile, this option appears on the
Client Options page.

For Pro sessions, the Client Locale specifies the language for the Web-to-Host client user interface, which
consists of the session window (including tool tips and the status bar), dialog and message boxes, error
messages, and Help.

The default value is English.

Multiple language scenarios
When running client sessions, users may need to view applications on an international host, require a
different country keyboard map, or require the Web-to-Host client user interface in another language. This
can be done by configuring the Host Character Set, Keyboard Mapping, and Client Locale options.

Different companies have different international language environments and require different display and/or
printer configurations. As such, it is impossible to provide a single procedure. This section lists possible
multi-language scenarios to help you determine how to best configure the options for your international
language environment.

In the following table, the first column lists the multi-lingual option, the second lists language scenarios, and
the third lists the suggested Web-to-Host settings.

Note: There are multiple keyboard listings because Web-to-Host provides several keyboard mapping
options. For information on individual settings, see the Help associated with the page in the Session
Configuration Manager.

Option If Then

Host language The host uses a language (codepage) other
than English (United States).

In the Host Character Set option, select the
language of the host.

Keyboard All clients are localized on one language. In the Keyboard Map option, select the
country keyboard map or specify the full path
of the Custom Keyboard Map file.

Clients are localized on different languages
as indicated by different regional settings
(Control page) on the client workstations.

Select Use Client Regional Settings from
the Keyboard Map option

Keyboard Locale (default).

Each client uses the keyboard map based on
its regional settings.

Users need or want control over their own
keyboard maps.

Enable end-user keyboard mapping. User-
created keyboard maps override any country
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Option If Then

keyboard map specified in the Keyboard
Map option.

Client user interface The client user interface uses a language
other than English and you want Web-to-Host
to use the same language.

Select the appropriate language from the
Client Locale option.

Note: Web-to-Host supports English,
French, and German.

The following are some other multi-language environments and suggested configurations:

• Clients connect to a host using the German language (codepage) and their regional settings are set to
German. In this scenario, you would set the client host character set, country keyboard map, and client
user interface language to German.

• Clients connect to a host using the English (United States) language (codepage), but their regional
settings are set to French (Canadian). In this scenario, you would set the client host character set to
English (United States), but the country keyboard map and client user interface language to French
(Canadian).

• Clients connect to a host using the English (United States) language (codepage), but some client
regional settings are set to French (Canadian) and others to German. In this scenario, you would want
to set the client host character set to English (United States), deploy a country keyboard map based on
the client regional settings, and set the language of the client user interface to either French or German.

• Clients connect to a host using the Spanish language (codepage) and their localization settings are set
to Spanish. In this scenario, you would set the Web-to-Host host character set and the country keyboard
map to Spanish. However, because Web-to-Host does not provide a Spanish client user interface, the
client user interface language must be set to English, French, or German.

Defining password level caching policy
Password level caching is involved with the AS/400 display or AS/400 file transfer.

On AS/400 hosts, password protection capabilities can be set to different levels, such as short or long
passwords. Client applications connecting to a AS/400 host must first query the password level set on the
host. This slows down overall system performance, increasing both connection time and network traffic.

To save time, Web-to-Host caches password-level data, by default. The first time the password level is
queried, the data is saved on the client PC. Afterwards, to avoid performance degradation, the cached
password level value is used for each connection.

Cached data is host specific. Once the password level has been cached for a particular host, it is used by
all sessions connecting to that host.

The following changes should be performed on the Java Script parts of the HTML session configuration
files:

AS/400 Printer Pro Client

Comment out the old HostPwdLevel property setting.

AS/400 Display Pro Client

• Comment out the old HostPwdLevel property setting.
• Add the this.ResolvePwdLevelPolicy property setting to the stAS400DisplayProps()

function:
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Property setting Description

this.ResolvePwdLevelPolicy = 0 Query and cache the password level value once and use it
from now on. Default value.

this.ResolvePwdLevelPolicy = 1 Always query and cache the password level value on each
connection.

this.ResolvePwdLevelPolicy = 2 Never query the host for the password level value and use
the lowest password level value on each connection.

Example:
function stAS400DisplayProps()
{
        this.SetMinFontSize = false;
        this.FontPointSize = 0;
        this.TypeAhead = true;
        this.AutoReset = false;
        this.StartupModelType = 2;
        // HostPwdLevel is now deprecated. It should be cleared from old 
sessions.
        //this.HostPwdLevel = false; 
        this.SuppressDialogs = false;
        this.ResolvePwdLevelPolicy = 2;     // (0=Once, 1=Always, 2=Never)
}

Publishing client profiles to users
You can use any usual Web publishing method to publish session profiles created by running the Session
Configuration Manager in server mode to users. For example, you can:

• Provide the URLs of the session profiles for users to enter in the address bar of their browsers.
• Create an HTML page containing links to the sessions and organize these links by host type or other

useful groupings.
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Web-to-Host Client Installation
This chapter describes procedures that users must follow when installing, updating, or removing Web-to-
Host files on the client workstation. If Rumba+ is also installed on the client workstation, users should
follow the procedures described in Coexistence: Pro and Rumba+ instead, to ensure successful
coexistence with Web-to-Host.

System requirements
This section describes the minimum system requirements and configurations required for client
workstations to run Web-to-Host components.

Client operating system
Web-to-Host supports these client operating systems:

• 64-bit Windows 10 and 11

Client browser
Web-to-Host supports:

• Google Chrome
• Internet Explorer 11
• Microsoft Edge
• Mozilla Firefox

Preparing to install the software
The following software needs to be installed on both client and server machines.

Server

• Web-to-Host Server

Client

Install the software in the following order:

1. .NET Framework 4.8 (if not already installed): Requires administrator rights.
2. NMServiceManager.msi taken from the server machine in \w2hlegacy\pro, if Google Chrome,

Microsoft Edge, or Mozilla Firefox are to be used. With Internet Explorer 11, this service is installed
when the first session is launched. Requires administrator rights.

Client install and upgrade
This section describes how users install and update Web-to-Host when the client does not also have
Rumba+ installed. Users must follow these procedures the first time they open a Web-to-Host session, and
repeat these procedures each time Web-to-Host is updated.

Web-to-Host Client Installation | 17



Installing Pro
Web-to-Host Pro components can be installed automatically using either the MSI Packager or the Service
Manager.

The MSI Packager provides complete local start capabilities. You create custom installations that can be
deployed on restricted-user systems. You can add all of the Pro emulation types, SimXfer tables for AS/400
file transfer, RSS Client security, a VBA-type script engine, localized client Help, and distribution packages.
For more information on MSI Packager, see the online MSI Packager User Guide supplied with the product.

Service Manager is installed on client workstations by a user with administrator rights. Once the Service
Manager has been installed, it downloads and installs all Pro components regardless of user rights. The
rest of this section describes installation using this component.

Note: Web-to-Host Pro 6.9.4 is compatible with Rumba+ version 10.2 only. All other Web-to-Host
components work with all versions of Rumba+. For details on co-existence restrictions for the Pro
component and Rumba+ , see Coexistence: Pro and Rumba+ on page 20.

Install procedure with Internet Explorer 11
1. From the browser, run the session HTML created by the Session Configuration Manager. As Web-to-

Host downloads and installs, a progress dialog is displayed.
2. Depending on your browser security settings, the Security Warning dialog box may appear asking if

you want to install the Service Manager. Click Yes to run the install. Once the Service Manager is
installed, all necessary Pro ActiveX controls are installed and the session opens.

Note: There may be instances where a message appears in the browser window telling you to restart
the computer. If it appears, click OK. After restarting, open Internet Explorer, click the extension you
want to connect to, then proceed with your host session.

Install procedure with Google Chrome, Microsoft Edge, or Mozilla
Firefox

1. On the client machine, run nmservicemgr.msi, located on the server machine in \w2hlegacy\pro.

2. From the browser, run the HTML session created by the Session Configuration Manager. 

As Web-to-Host downloads and installs, a progress dialog is displayed.

Silent Install procedure
As mentioned above, the standard Web-to-Host Pro installation displays a progress dialog while
downloading and installing. However, it is possible to run a silent installation. That is, an install and
download with no progress dialog displayed. To do this:

1. Navigate to \w2hlegacy\config\productcfg.xml. This file contains component descriptions and
version numbers.

2. In the <product_info> section, change the silent_install property to true. By default it is set
to false. After editing, silent_install should be:

<silent_install value="true"/>.

3. After making the necessary change to productcfg.xml, follow the standard installation procedure.

Uninstalling the Pro client
1. From the Windows Control Panel, go to Programs and Features, select Micro Focus OnWeb Web-to-

Host Pro Client 6.9.4, then click Uninstall.
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2. Click OK in the Web-to-Host Pro Client Uninstall message box.
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Coexistence: Pro and Rumba+
Rumba+, a traditional desktop host emulation application that runs on Windows clients, and Web-to-Host
Pro have shared executable files. Consequently, certain conditions must be met for both products to coexist
on the same client workstation.

Web-to-Host Pro 6.9.4 is compatible with Rumba+ 10.2.

Coexistence with Rumba+
On the client workstation, the Rumba+ version must be 10.2. The language and the installation location of
Rumba+ and Web-to-Host Pro client are defined by the product, which is installed first.

If an incompatible version of either Rumba+ or Web-to-Host is installed, an error message appears.

Setting a custom install path
When Web-to-Host installation comes first, and its installation location must be customized, use the MSI
Packager tool located in \utils\MSIPackager. For more information on MSI Packager, see the Help
supplied with the tool.

Upgrading Pro and Rumba+
When you install a new Web-to-Host version or Service Pack, the new Pro software automatically
downloads to the client workstation when the user opens a Pro session. The start-up program compares
the Pro and Rumba+ desktop versions. If the versions are not compatible, the user receives a message.
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User Profile Configuration
There are two types of Pro configuration settings in Web-to-Host:

• Administrator settings - created by Web-to-Host administrators using the Session Configuration
Manager and deployed to the users as HTML session files.

• User settings - stored in a local configuration file (.cph). If the administrator has enabled editing
specific options in the Session Configuration Manager, users create their own customized local
configurations settings for options, such as interface color, toolbars, menus, keyboard map or logon
script.

In some previous versions of Web-to-Host, when the administrator made changes to Pro HTML session
files, all user changes were reset (deleted).

Web-to-Host 6.9.4 provides a mechanism that preserves user changes. The SCM Wizard changes do not
automatically delete the user's .cph file. Settings which only the user can set are not deleted when you,
the administrator, change the HTML session files. This means users do not lose their customized
environment with its colors, toolbars, and keyboard mappings.

This chapter lists the conditions that determine which configuration file takes precedence, if both an HTML
session files and a user .cph file exist. It also explains how the configuration file is handled when included
within a distribution package.

Rules defining Pro behavior
This section lists the rules for determining the settings implemented - default settings in HTML session files
or user customized .cph settings.

No user configuration (.cph) file exists
The first time the user opens a session no user .cph file exists. Consequently, the user
receives the options defined in the Session Configuration Manager.

Existing user configuration (.cph) file

When a user .cph file exists, the following rules apply:

• If a .cph file exists, but no particular option is enabled, the user receives the default
options set in the Session Configuration Manager. This is because you have not given
the user permission to modify options. For example, if a user .cph file exists but you
did not select Enable Edit Options, the user cannot create a customized configuration
with features, such as word wrap or type ahead. The user is required to use the values
set in the HTML session file.

• If a .cph file exists and a particular option is enabled, the user can customize the
configuration. For example, if Enable Edit Options is selected, the user can create a
personalized environment that allows features, such as word wrap, type ahead, and
keyboard auto reset. In this case, if you make changes to the HTML session file
including those features which the user has customized, the user .cph file is not
deleted and the customized environment remains in effect.

To enforce the use of the default HTML settings, you should disable the relevant option,
for example, Enable Edit Options. Then the HTML settings override user settings for
those options only. All other user configurations remain in effect.
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User configuration files in a distribution package
As an administrator you can create a user .cph file from the session’s HTML configuration and include it in
a distribution package. This means the user starts with a customized, pre-configured session. It also
means that you can provide the user with more configurable client options than you can assign using the
Session Configuration Manager.

You can enable a particular client option, modify its settings using the option dialog, insert the session
configuration file into a distribution package, then optionally disable the option (depending on whether you
want to allow further user editing).

For example, selecting Enable Edit Options in the Session Configuration Manager allows you to open the
Edit Options dialog box within a session and choose clipboard and parsing options that are not part of the
Session Configuration Manager. The additional settings are added to the user .cph file. Then you can
associate the session .cph file to a distribution package. If you want to maintain standardization, you can
disable edit options.

In all cases, if you modify the distribution package, the new user configuration replaces the user’s previous
file, deleting all user settings.
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User Data File Locations
Web-to-Host stores user data on the client in a location specified by the user’s environment. This location
is determined by several environmental variables, such as the client operating system and browser, and
whether roaming user profiles are enabled.

Roaming profile support for Pro sessions
While normal Windows profiles store user environment settings on the client workstation, roaming user
profiles store this information on their server. When a user logs on to the server, the roaming profile is
downloaded to the client workstation. When the user logs off the server, the roaming profile (along with any
changes) is uploaded back to the server. This scenario enables the user to work on different client
workstations while using the same environment settings.

Web-to-Host supports roaming user profiles for Pro sessions. Users with roaming profiles can access their
custom settings (such as keyboard maps and macros) when running Pro sessions on various workstations.

Default paths for user data files
This section lists the user data file locations for Pro client workstations with a default Windows installation
and using Internet Explorer.

If Rumba+ has been previously installed on the client workstation, Web-to-Host stores user data files in the
same location. If not, these locations are read from the Windows registry.

Roaming path:

C:\Users\<user_name>\AppData\Roaming\Micro Focus\Rumba

Local path:

C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba

You can use the MSI Packager to modify default user data file locations. For more information on the MSI
Packager see the online help supplied with the utility.
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Creating a Trace
The Trace utility is a diagnostic tool for troubleshooting host communications and connectivity problems.
With this utility you can trace activity within host software or other standardized components linked to
OnWeb Web-to-Host. This section describes how to use the Trace utility to get a binary trace that can be
sent to Micro Focus Technical Support for additional help troubleshooting your problems.

Pro uses the Rumba+ Desktop Trace Trace utility that comes with Rumba+ as standard. If Rumba+ is
installed, use its trace utility.

If Rumba+ is not installed, you can download the Trace utility from the server hosting Web-to-Host. Type
the following URL into the address bar of any Web browser.

http://<servername>/w2hlegacy/utils/installrumbatrace.msi

Important: Before starting the procedure, close all applications. If you are using Rumba+, ensure it is
closed.

To take a correct binary trace:

1. If Rumba+ is installed, select Start > All Programs > Micro Focus Rumba+ Desktop > Rumba+
Desktop Tools > Rumba+ Desktop Trace. Otherwise, select Start > All Programs > RUMBA Trace >
RUMBA Trace.

2. On the menu bar, select Options > Configuration.

3. On the API Selection page, click Select All. After all entries have been selected, click Reset All.

4. On the Output page, in the Formatted Output section, select Display.

5. In the Binary Output section select Binary File. The box next to the option becomes available.

6. Enter the full path for the binary file being created (or browse to it). or example, you might assign the file
the call log number, c368758.bin. All file names should end with the extension .bin.

7. Click OK.

8. Minimize the Rumba+ Desktop Trace window that appears.

9. Run the Rumba+ application that is causing the problem as you normally would, starting from the
connection (for example, Rumba+ display, or printer). Let the program run until the problem appears
(error message, session hanging, or any other problem).

10.Log off and disconnect from the host.

11.Maximize the Rumba+ Desktop Trace window, then select File > Exit.

12.Send the .bin file you created by email to Micro Focus Technical Support.

24 |  Creating a Trace



Contacting Micro Focus
Our Web site gives up-to-date details of contact numbers and addresses.

Further information and product support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus Customer Care Web site, where you can download
fixes and documentation updates.

• The Examples and Utilities section of the Micro Focus Customer Care Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus Customer Care Web site, that includes
troubleshooting guides and information about how to raise an incident.

To connect, enter https://www.microfocus.com/en-us/support in your browser.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists.

• The Micro Focus YouTube channel for videos related to your product. .

Information we need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus Customer Care can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out this number, look in the subject line and body of your Electronic Product

Delivery Notice email that you received from Micro Focus.

Contact information
Our Web site gives up-to-date details of contact numbers and addresses.

Additional technical information or advice is available from several sources.
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The product support pages contain considerable additional information, including the Product Updates
section of the Micro Focus Customer Care Web site, where you can download fixes and documentation
updates. Go to Micro Focus Product Updates.

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Login.

If you are a Micro Focus Customer Care customer, please see the Welcome to Customer Care document
that includes information about downloading and licensing your product, contacting Customer Care, and
about reporting an incident. You can download it from our Web site. Support from Micro Focus may be
available only to customers who have maintenance agreements.
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MICRO FOCUS END USER LICENSE
AGREEMENT

IMPORTANT: LICENSOR PROVIDES LICENSED SOFTWARE TO LICENSEE UNDER THIS END USER
LICENSE AGREEMENT (THE “AGREEMENT”). THIS AGREEMENT GOVERNS LICENSEE’S
INSTALLATION AND USE OF THE VERSION OF THE LICENSED SOFTWARE IDENTIFIED IN THE
APPLICABLE PRODUCT ORDER, OR IF NOT ACQUIRED VIA A PRODUCT ORDER, LICENSEE’S
INSTALLATION OR USE OF THE LICENSED SOFTWARE CONSTITUTES ACCEPTANCE OF THIS
AGREEMENT. THE TERMS AND CONDITIONS OF THIS AGREEMENT MAY BE DIFFERENT FROM
THE AGREEMENT(S) THAT ACCOMPANIED EARLIER RELEASES OF THE LICENSED SOFTWARE.
PLEASE READ THIS AGREEMENT CAREFULLY BEFORE PROCEEDING, AS IT MAY CONTAIN
ADDITIONAL RESTRICTIONS ON YOUR USE OF THE SOFTWARE. THIS AGREEMENT
SUPERSEDES AND CONTROLS OVER ANY OTHER TERMS PROVIDED TO LICENSEE REGARDING
LICENSEE’S USE OF THE LICENSED SOFTWARE, WHETHER WRITTEN OR ORAL, AS PART OF A
SIGNED AGREEMENT (INCLUDING, BUT NOT LIMITED TO, MASTER AGREEMENTS AND
PORTFOLIO TERMS, UNLESS A DIFFERENT AGREEMENT IS EXPRESSLY REFERENCED IN A
PRODUCT ORDER OR EXECUTED BY LICENSOR AND LICENSEE SPECIFYING THAT IT APPLIES
TO THE VERSION OF THE LICENSED SOFTWARE TO WHICH THIS AGREEMENT RELATES), A
CLICK-WRAP AGREEMENT PROVIDED WITH THE LICENSED SOFTWARE OR OTHERWISE (SUCH
TERMS REFERRED TO AS THE “OTHER AGREEMENT”), EVEN IF SUCH OTHER AGREEMENT WAS
EMBEDDED WITHIN PREVIOUSLY LICENSED SOFTWARE. LICENSOR RESERVES THE RIGHT TO
UPDATE, AMEND, AND/OR MODIFY THIS AGREEMENT FROM TIME TO TIME, AND MAY INCLUDE
SUCH UPDATED AGREEMENT WITH OR EMBEDDED IN FUTURE VERSIONS OF THE LICENSED
SOFTWARE. PLEASE DIRECT ANY QUESTIONS TO THE MICRO FOCUS LEGAL DEPARTMENT AT
LEGALDEPT@MICROFOCUS.COM.

ENTERING INTO THIS AGREEMENT DOES NOT CONSTITUTE A SALES TRANSACTION. THE SALE
OF A LICENSE TO SOFTWARE PRODUCTS TAKES PLACE UNDER PRODUCT ORDERS WHICH
(UNLESS OTHERWISE STATED IN THE PRODUCT ORDER) INCORPORATE THE TERMS OF THIS
AGREEMENT.

Capitalized terms in this Agreement are defined as follows:

“Additional License Authorization” or “ALA” means the additional specific software license terms that
govern the authorized use of a given software product of Licensor, including requirements for any non-
production use rights described in the Non-Production Licensing Guide, and License Options available for
that software product, along with additional terms or conditions applicable to a given License Option, all of
which are made a part of this Agreement. The applicable Additional License Authorization for the Licensed
Software is either attached hereto or can be found here:  https://software.microfocus.com/en-us/about/
software-licensing by product name and version; all references in this Agreement to “Additional License
Authorization” or “ALA” shall refer to the ALA that corresponds to the version of the Licensed Software.

“Documentation” means the Licensor user documentation that is included with the Licensed Software.

“Licensee” means the legal entity or individual that is identified in the applicable Product Order or who has
rightfully received a license to the Licensed Product.

“License Option” means the type of license available for a given software product (such as a named user
license, concurrent user license or server license). In addition to the ALA, a License Option may be set
forth in a Product Order or an agreement executed in writing by Licensee and Licensor.

“Licensor” means the applicable Micro Focus entity and its affiliates who own the intellectual property
rights in Licensed Product.
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“Licensed Software” mmeans the executable version of Licensor’s software listed in the Product Order or
otherwise provided to or rightfully acquired by Licensee. This Agreement shall govern the use of any
update to the Licensed Software that Licensee receives pursuant to a separate support and maintenance
agreement as described in Section 4 below, unless such update contains, comes with, or is otherwise
specifically governed by a different end user license agreement.

“Product Order” means an agreement between Licensor and Licensee that consists of a document that
has been (i) submitted by Licensee describing the License Option(s) to be purchased for the Licensed
Software, and (ii) accepted by Licensor (a) in writing or (b) by delivering the Licensed Software to Licensee,
whichever occurs first. A Product Order may also consist of a written quote, or other written document
issued by Licensor (the “Quote”), (i) describing the License Options for the Licensed Software to be
purchased, and (ii) that is accepted by Licensee before the Quote expires either by (a) returning the Quote
signed by an authorized representative of Licensee, (b) issuing a purchase order that references the Quote
(if the Quote expressly allows acceptance in this manner), or (c) paying Licensor the fees listed in the
Quote. Unless otherwise expressly set forth in the relevant Product Order, each Product Order incorporates
the terms and conditions of this Agreement, and in no event will any different or additional terms of a
purchase order or similar document issued by Licensee in connection with this Agreement or a Product
Order apply, and any such additional or different terms are hereby rejected by the Licensor. For purposes
of this paragraph, “Licensor” shall also include the relevant Micro Focus entity as defined above and its
authorized distributors and resellers. Any conflicting or additional terms in a Product Order accepted by an
authorized distributor or reseller of Licensor shall have no effect unless such terms have been agreed to by
the applicable Micro Focus entity in writing.

“Third Party Component” means any run time or other elements owned or licensed to Licensor by a third
party (other than open source code or elements) which may be embedded in the Licensed Software.

“Third Party Software” means additional or accompanying software owned or licensed by a third party
(such as Adobe Acrobat or Microsoft Internet Explorer, but not any open source code or elements) that
may be specified in the Documentation or in a file accompanying such Licensed Software.

“Warranty Period” means the ninety (90) day time frame beginning on date of delivery of the Licensed
Software to Licensee (Licensed Software delivery is deemed to occur when the Licensed Software is
physically delivered to Licensee EXWORKS or made available for download to Licensee).

1. GRANT OF LICENSE; LICENSE CONDITIONS.

A. License Grant. Subject to Licensee’s compliance with the terms and conditions of this Agreement
(including but not limited to payment of applicable fees), Licensor grants to Licensee a personal, non-
transferable, non-sublicensable and non-exclusive license to use the Licensed Software as authorized
by the License Option(s) specified in the ALA solely for Licensee’s internal business operations,
functions and benefit, and not for commercialization of the Licensed Software or to provide services or
benefit to any affiliates or subsidiaries of Licensee or any other third party. Throughout the license term,
Licensee agrees to: (i) implement internal safeguards to prevent any unauthorized copying, distribution,
installation, use of, or access to, the Licensed Products and associated support and maintenance, or
any other breach of this Agreement; and (ii) take all necessary steps to destroy or erase all Licensed
Software codes, programs, Documentation, and other proprietary information of Licensor before
disposing of any media or hardware. Licensor will provide any license key necessary for activation and
use of the Licensed Software. Licensor is not liable or responsible for lost or broken license keys and is
not obligated to replace license keys or issue new license keys unless (1) Licensee has purchased a
support and maintenance plan for the applicable Licensed Software that specifically covers the
issuance of new or replacement keys and (2) the applicable version of the Licensed Software is then
generally available for distribution by Licensor. If Licensee has not paid for such a support and
maintenance plan, replacement or new license keys may be available for purchase at Licensor’s then-
current list price for applicable new licenses.

B. Evaluation Licenses. With respect to any Licensed Software provided to Licensee solely for
evaluation purposes (an “Evaluation License”), in the event of conflict this Section 1.B shall prevail over
any other provisions set forth in this Agreement. An Evaluation License may be used for a period of no
more than thirty (30) days from the date the Licensed Software is provided to Licensee (“Evaluation
Term”), unless a different period is specified in writing by Licensor. An Evaluation License may be used
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solely for Licensee’s internal evaluation and testing purposes on a single computer system and not for
development, commercial, or production purposes. For Licensed Software subject to an Evaluation
License, (i) Licensee may not reproduce or distribute the Licensed Products; and (ii) Licensee’s results
of benchmark or other performance tests run on or using the Licensed Software may not be disclosed
to any third party without Licensor’s prior written consent. At any time during the Evaluation Term or
upon completion thereof, Licensee may, upon written notification to Licensor and payment of the
applicable license fee, replace the Evaluation License with a license to use the Licensed Software that
is not restricted to evaluation purposes. In the absence of such notification by Licensee, the Evaluation
License shall automatically terminate at the end of the Evaluation Term, and Licensee shall return, or, if
Licensor so directs, delete and destroy all such Licensed Software and provide Licensor with written
confirmation of its compliance with this provision. Upon written request from Licensee, Licensor may, in
its sole discretion, grant Licensee an extension in writing prior to the expiration of the Evaluation Term.
Other than updates to Licensed Software provided as part of support and maintenance, Licensed
Software provided by Licensor free of license fee charge shall be deemed to be provided for evaluation
purposes only. Licensed Software furnished under an Evaluation License is provided without any
contractual obligation of maintenance and support by Licensor and is provided “as is” without
warranties, implied or express, of any kind.

C. Bundles/Suites. If the Licensed Software is licensed in a bundle or suite of multiple products, and the
applicable Product Order specifies the License Option and license count for the bundle or suite (but not
the individual product components of the bundle or suite), then each product in the bundle or suite shall
share such license type and count. For example, individual products in the bundle or suite cannot be
used by multiple users if only one user license is purchased (for user-based licenses) and cannot be
installed on multiple devices or servers if only one device or server license is purchased (for device or
server-based licenses).

2. USE RESTRICTIONS. Except as may be otherwise specifically permitted in the applicable ALA,
Licensee agrees not to, directly or indirectly:

A. Copy, distribute or use the Licensed Software, in whole or in part (such as any portion, feature,
function, or user interface) without paying Licensor the applicable fees;

B. Use the Licensed Software as a service, or for timesharing, facilities management, outsourcing,
hosting, service bureau use, or for providing other application service (ASP) or data processing services
to third parties or for like purposes, or permit the use of the Licensed Software by a third party or permit
access by or use for the benefit of any third party without executing a separate distribution agreement
for the Licensed Software and paying Licensor the applicable required additional fees;

C. Modify or create derivative works of the Licensed Software, or decrypt, translate, disassemble,
recompile, decompile or reverse engineer the Licensed Software or attempt to do so (except to the
extent applicable law specifically permits such activity, in which case Licensee must provide Licensor
with detailed information regarding such activities);

D. Alter, destroy, or otherwise remove any proprietary notices or labels on or embedded within the
Licensed Software;

E. Use the Licensed Software in a manner other than as specifically permitted in this Agreement or an
ALA;

F. Assign, sell, resell, license, rent, lease, lend, sublicense, outsource or otherwise transfer the Licensed
Software to any third party, without first paying Licensor the applicable required license fees and
obtaining Licensor’s prior written consent;

G. Authorize, allow or appoint any third party to do any of the foregoing. For the avoidance of doubt,
third parties include, without limitation, contractors and consultants (including contractors and
consultants retained to provide services solely for the benefit of Licensee), outsourcers, Licensee’s
affiliates and subsidiaries, parent companies, customers, and the public; or

H. Publish or disclose to third parties any evaluation or benchmarking of the Licensed Software without
Licensor's prior written consent. Notwithstanding the foregoing, Licensee may: (i) make a reasonable
number of archival back-up copies of the Licensed Software and (ii) make a reasonable number of
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copies of the Documentation. Licensee shall reproduce all copyright and other proprietary rights notices
appearing in or on the Licensed Products, including notices of all third party suppliers.

3. TERM OF LICENSE. This Agreement and the license term for the Licensed Software granted herein is
perpetual, unless a subscription/term license has been purchased by Licensee (in which case the
license term shall be set forth in the Product Order or ALA), and is subject to earlier termination as
provided in this Section 3. If Licensee has purchased a subscription/term license, such license shall
automatically terminate upon expiry of such subscription/term, unless earlier terminated under this
Section 3. Licensor may terminate this Agreement, along with any or all licenses then in effect with
Licensee, immediately by giving Licensee written notice of termination in the event that (i) Licensee
breaches any term or condition of this Agreement and fails to remedy such breach within ten (10) days
of receipt of Licensor’s notice detailing such breach; (ii) Licensee becomes insolvent, has a receiver
appointed, or files for or has filed against it, liquidation, bankruptcy or analogous proceedings; or (iii)
Licensee infringes or misappropriates the intellectual property rights of Licensor. Termination shall be
without prejudice to any other rights or remedies Licensor may have. In the event of any termination,
Licensee’s license(s) to install, access or use the Licensed Software will immediately terminate, and
Licensee shall destroy and erase all copies of such Licensed Software in its possession or control and
provide written certification to Licensor that it has complied with this provision. Early termination of this
Agreement shall not entitle Licensee to any refund or reimbursement of any previously paid fees. The
rights and obligations of the parties contained in Sections 3 (Term of License), 6 (Disclaimer of
Warranty), 7 (Limitation of Liability), 8 (High Risk Uses), 9 (Ownership), 10 (Third Party Software and
Components), 11 (Notice to U.S. Government End Users), 12 (License Fees and Payment Terms), 13
(Audits), 15 (Privacy and Use of Licensee Information),16 (Licensee Trademark and Feedback) and 17
(Miscellaneous) will survive the termination or expiration of this Agreement.

4. SUPPORT AND MAINTENANCE. Licensee is not entitled to any updates to the Licensed Software,
unless Licensee purchases maintenance and support services pursuant to Licensor’s then-current
applicable standard maintenance and support agreement, which can be found at https://
www.microfocus.com/support-and-services/maintenance-and-support-agreements/ or can be provided
by Licensor at Licensee’s request. Maintenance and support services (including, but not limited to, any
new versions, bug fixes, and patches) provided by Licensor will be subject to such agreement. Where
Licensee purchases maintenance and support for any Licensed Software, Licensee hereby agrees to
purchase or keep current on such maintenance and support services for all of Licensee’s licensed units
of such Licensed Software product, regardless of License Option.

5. LIMITED WARRANTY. Licensor warrants for the Warranty Period that: (i) if the Licensed Software is
supplied via media, the media will be free from defects in materials or workmanship under normal use,
and (ii) the copy of the Licensed Software delivered to Licensee substantially conforms in all material
respects to the Documentation. Licensee’s sole and exclusive remedy for any defective media supplied
by Licensor shall be Licensor’s repair or replacement of such defective media free of charge, provided
that the defective media is returned to Licensor during the Warranty Period. During the Warranty Period,
Licensee’s sole and exclusive remedy for not meeting part (ii) of the above warranty shall be the repair
or replacement of the Licensed Software by Licensor free of charge so that it substantially conforms to
the Documentation or, if Licensor reasonably determines that such remedy is not economically or
technically feasible, Licensee shall be entitled to a full refund of the license fee and any maintenance
fee paid for such Licensed Software. Upon such refund, Licensee’s license to use such Licensed
Software will immediately terminate. The warranties set forth in this Section 5 shall not apply if the
defects in the Licensed Software or media result from: (a) failure to use the Licensed Software in
accordance with the Documentation, this Agreement or ALAs; (b) the malfunctioning of Licensee’s
equipment or network; (c) accident, neglect, or abuse; (d) service by any unauthorized person; (e) other
software used by Licensee and not provided by Licensor, or for which the Licensed Software is not
designed or licensed for such use; (f) Third Party Software that is not a Third Party Component; (g) any
other cause occurring after initial delivery of the Licensed Software or media to Licensee, unless
caused directly by Licensor. Licensor has no responsibility for any claims made outside of the Warranty
Period. The foregoing warranty shall not apply to any free-of-charge Licensed Software or updates
provided under support and maintenance. THE FOREGOING WARRANTIES DO NOT APPLY, AND
LICENSOR DISCLAIMS ALL WARRANTIES, WITH RESPECT TO ANY THIRD PARTY SOFTWARE
THAT IS NOT A THIRD PARTY COMPONENT. The warranties set forth in this Section 5 will not apply
and will become null and void if Licensee materially breaches any provision of this Agreement.
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6. DISCLAIMER OF WARRANTY. EXCEPT FOR THE LIMITED WARRANTY SET FORTH IN SECTION
5, THE LICENSED PRODUCTS ARE PROVIDED TO LICENSEE “AS-IS” WITHOUT WARRANTY OF
ANY KIND. LICENSOR DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE
LICENSED SOFTWARE WILL MEET LICENSEE’S REQUIREMENTS, THAT OPERATION WILL BE
UNINTERRUPTED, ACHIEVE ANY INTENDED RESULT, BE COMPATIBLE, OR WORK IN
COMBINATION WITH ANY OTHER SOFTWARE, APPLICATIONS, OR SYSTEMS, MEET ANY
PERFORMANCE OR RELIABILITY STANDARDS, OR BE ERROR FREE, OR THAT ANY ERRORS
OR DEFECTS CAN OR WILL BE CORRECTED. EXCEPT AS SET FORTH HEREIN AND TO THE
EXTENT PERMITTED BY LAW, ALL OTHER WARRANTIES WITH RESPECT TO THE LICENSED
PRODUCTS, WHETHER EXPRESS OR IMPLIED, STATUTORY OR OTHERWISE, INCLUDING, BUT
NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY, QUALITY, FITNESS FOR A
PARTICULAR PURPOSE, TITLE, NON-INFRINGEMENT, AND WARRANTIES THAT MAY ARISE OUT
OF COURSE OF DEALING, COURSE OF PERFORMANCE, USAGE, OR TRADE PRACTICE ARE
EXPRESSLY DISCLAIMED BY LICENSOR AND ITS THIRD-PARTY SUPPLIERS AND AFFILIATES.
LICENSEE ACKNOWLEDGES THAT LICENSEE IS RESPONSIBLE FOR THE SELECTION OF THE
LICENSED SOFTWARE TO ACHIEVE LICENSEE’S INTENDED RESULTS AND FOR THE
INSTALLATION AND/OR USE OF, AND RESULTS OBTAINED FROM, THE LICENSED SOFTWARE.

7. LIMITATION OF LIABILITY.

A. Aggregate Cap. IN NO EVENT SHALL ANY LIABILITY OF LICENSOR OR ITS AFFILIATES OR
ANY OF ITS OR THEIR RESPECTIVE LICENSORS OR SERVICE PROVIDERS UNDER OR IN
CONNECTION WITH THIS AGREEMENT EXCEED, IN THE AGGREGATE, THE AMOUNTS PAID BY
LICENSEE FOR THE LICENSED SOFTWARE AND THE INITIAL PERIOD OF MAINTENANCE AND
SUPPORT GIVING RISE TO THE APPLICABLE CLAIM.

B. Waiver of Liability. IN NO EVENT SHALL LICENSOR OR ITS AFFILIATES OR ANY OF ITS OR
THEIR RESPECTIVE LICENSORS OR SERVICE PROVIDERS BE LIABLE FOR ANY INDIRECT,
SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR SIMILAR DAMAGES, LOSS OF PROFITS,
BUSINESS, DATA, OR PROGRAMS (INCLUDING, BUT NOT LIMITED TO, THE COST OF
RECOVERING OR REPLACING SUCH DATA OR PROGRAMS), LOSS, DAMAGE OR ANY COSTS
DUE TO INTERRUPTION, DELAY, OR INABILITY TO USE THE LICENSED SOFTWARE, WHETHER
ARISING OUT OF OR IN CONNECTION WITH THIS AGREEMENT, EVEN IF INFORMED OF THE
POSSIBILITY OF SUCH DAMAGES IN ADVANCE.

C. Scope. THE LIMITATIONS AND EXCLUSIONS OF THIS SECTION 7 APPLY TO ALL CAUSES OF
ACTION, INCLUDING, WITHOUT LIMITATION, BREACH OF CONTRACT, BREACH OF WARRANTY,
NEGLIGENCE, STRICT LIABILITY, MISREPRESENTATION AND OTHER TORTS. THESE
LIMITATIONS AND EXCLUSIONS APPLY COLLECTIVELY TO LICENSOR, ITS PARENTS,
AFFILIATES, AND SUBSIDIARIES AND EACH OF THEIR RESPECTIVE EMPLOYEES,
CONTRACTORS, AND SUPPLIERS. NOTWITHSTANDING THE FOREGOING, NOTHING IN THIS
SECTION 7 EXCLUDES LIABILITY FOR WILLFUL MISCONDUCT OR FRAUDULENT
MISREPRESENTATION.

D. Exclusive Remedy. LICENSEE’S REMEDIES IN THIS AGREEMENT ARE LICENSEE’S
EXCLUSIVE REMEDIES. LICENSEE AGREES THAT, IN ENTERING INTO THIS AGREEMENT, IT DID
NOT RELY ON ANY REPRESENTATIONS (WHETHER WRITTEN OR ORAL) OF ANY KIND OTHER
THAN THOSE EXPRESSLY SET OUT IN THIS AGREEMENT.

E. Essential Purpose. LICENSEE FURTHER ACKNOWLEDGES THAT THE LIMITATIONS AND
EXCLUSIONS OF LIABILITY IN THIS SECTION 7 APPLY TO THE FULLEST EXTENT PERMITTED
BY LAW AND ARE AN ESSENTIAL ELEMENT OF THIS AGREEMENT AND THAT, IN THE ABSENCE
OF SUCH LIMITATIONS AND EXCLUSIONS, THE PRICING AND OTHER TERMS AND CONDITIONS
SET FORTH HEREIN WOULD BE SUBSTANTIALLY DIFFERENT. THE LIMITATIONS AND
EXCLUSIONS SET FORTH IN THIS SECTION 7 SHALL APPLY EVEN IF THE LICENSEE’S
REMEDIES UNDER THIS AGREEMENT FAIL OF THEIR ESSENTIAL PURPOSE.

F. Free Software. IF LICENSOR PROVIDES LICENSEE WITH ANY LICENSED SOFTWARE FREE-
OF-CHARGE OR UNDER AN EVALUATION LICENSE, TO THE EXTENT PERMITTED BY LAW,
LICENSOR SHALL NOT BE RESPONSIBLE FOR ANY LOSS OR DAMAGE TO LICENSEE, ITS
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CUSTOMERS, OR ANY THIRD PARTIES CAUSED BY THE LICENSED SOFTWARE THAT IT MAKES
AVAILABLE TO LICENSEE.

8. HIGH-RISK USES. The Licensed Software is not fault tolerant, nor designed, manufactured, or intended
for use in hazardous environments requiring fail-safe performance (including, without limitation, the
operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life
support machines, or weapons systems) in which failure of the Licensed Software could lead directly or
indirectly to death, personal injury, or severe physical or environmental damage. Licensor and its
suppliers shall have no liability for any use of the Licensed Software in any high-risk situations.

9. OWNERSHIP. The Licensed Products are provided under license, and not sold, to Licensee. The only
rights in the Licensed Products are the licenses expressly stated in this Agreement and no other rights
are implied or granted by estoppel. Licensor (and its affiliates) and its and their licensors and third party
suppliers retain ownership of, and reserve all rights in and to, the Licensed Products, including all
copies thereof, and all intellectual property rights arising out of or relating to the Licensed Products.
Licensee shall use reasonable efforts to safeguard the Licensed Products (including all copies thereof)
from infringement, misappropriation, theft, misuse, or unauthorized access. Licensee shall promptly
notify Licensor if it becomes aware of any infringement or misappropriation of the Licensed Products
and shall fully cooperate with Licensor, at Licensor’s expense, in any legal action taken by Licensor to
enforce its intellectual property rights.

10.THIRD PARTY SOFTWARE AND COMPONENTS. The Licensed Software may come with or require
Third Party Software that Licensee shall license directly from the third party licensor pursuant to such
third party’s terms and conditions and not this Agreement. Additionally, some Licensed Software may
include certain Third Party Components and open source software. Such open source software and
Third Party Components may also be loaded on the Licensed Software media. Third Party Components
are licensed to Licensee under this Agreement; open source software is licensed pursuant to the
applicable open source license. To the extent applicable, information about the open source software
may be found (i) in a file accompanying the applicable Licensed Software or (ii) in the Documentation or
ALA. Licensee shall not directly access any Third Party Components other than with or as part of the
Licensed Software. Licensee agrees that to the extent required by a third party licensor or supplier of a
Third Party Component, that third party licensor or supplier is an intended third party beneficiary of this
Agreement as necessary to protect intellectual property rights in the Licensed Software and limit certain
uses thereof.

11.NOTICE TO U.S. GOVERNMENT END USERS. The Licensed Products are deemed to be “Commercial
Items,” as defined at 48 C.F.R. §2.101, consisting of “Commercial Computer Software” and “Commercial
Computer Software Documentation,” as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R.
§227.7202, as applicable. Consistent with such sections, the Licensed Products are licensed to U.S.
Government end users (i) only as Commercial Items, and (ii) with only those rights as are granted
pursuant to this Agreement.

12.LICENSE FEES AND PAYMENT TERMS. Licensee agrees to pay the applicable license fees for the
Licensed Products within thirty (30) days of the date of invoice or such other date as agreed in writing
by the parties. Software license fees are non-refundable, except as provided in Section 5 above, and
shall be paid without any deduction or tax withholding. Software License fees are exclusive of any
applicable transportation charges, sales, use, value added tax, and other applicable taxes and duties,
and all such amounts shall be paid or reimbursed by Licensee. Licensee shall be liable for all
outstanding past due amounts, which shall accrue interest at the rate of 1.5% per month compounded
or, if lower, the maximum rate allowed by applicable law, and any collection costs associated with the
collection of any past due amounts.

13.AUDITS. Licensor or an Auditor (as defined below) has the right to verify Licensee’s compliance with
the licenses issued under Product Orders, the applicable ALAs and this Agreement (please see Micro
Focus License Compliance Charter at http://supportline.microfocus.com/licensing/licVerification.aspx,
which can also be provided by Licensor at Licensee’s request). Licensee agrees to:

A. Recordkeeping. Keep, and upon Licensor’s request, provide records, sufficient to certify Licensee’s
compliance with this Agreement based on the applicable License Option(s) (including applicable license
metric and other terms and conditions) for the Licensed Software, which may include but are not limited
to, serial numbers, license keys, logs, the location, model (including quantity and type of processor) and
serial number of all machines on which the Licensed Software is installed or accessed or from which
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the Licensed Software can be accessed, the names (including corporate entity) and number of users
accessing or otherwise able to access the Licensed Software, metrics, reports, copies of the Licensed
Software (by product and version), and network architecture diagrams as they may relate to Licensee’s
licensing and deployment of the Licensed Products and associated support and maintenance;

B. Questionnaire. Within seven (7) days of Licensor’s request, Licensee shall furnish to Licensor or its
designated independent auditor (“Auditor”) a completed questionnaire provided by Licensor or Auditor,
accompanied with a written statement signed by a director of Licensee certifying the accuracy of the
information provided; and

C. Access. Provide representatives of Licensor or Auditor any necessary assistance and access to
records and computers to allow an inspection and audit of Licensee’s computers and records, during
Licensee’s normal business hours, for compliance with licenses, the applicable ALAs, and this
Agreement, and fully cooperate with such audit.

D. Non-Compliance. In the event that Licensee has, or at any time has had, unlicensed installation, use
of, or access to the Licensed Software or has otherwise breached this Agreement or an ALA (a “Non-
Compliance”), without prejudice to any other rights or remedies Licensor may have, including, without
limitation, injunctive relief, Licensee shall, within thirty (30) days’ notice of such Non-Compliance to
Licensee, purchase sufficient licenses and/or subscriptions and associated support and maintenance to
cure the Non-Compliance, by paying Licensor’s current (as of the date of such additional purchase) list
license fees and 12-month support and maintenance fees to Licensor for such additional licenses, plus
Licensor’s current (as of the date of such additional purchase) list term license and support and
maintenance fees and interest (compounded at 1.5% monthly or the maximum rate permitted by
applicable law if lower) for such additional licenses for the time period from the commencement of the
Non-Compliance until payment of the aforementioned fees, with interest payable even if an invoice was
not issued at the time the Non-Compliance occurred. For purposes of the foregoing, “list” shall mean
Licensor’s full list price as set forth in Licensor’s standard price list that is current as of the
commencement of the audit without any volume or other discount. If Licensee’s Non-Compliance results
in an underpayment of license fees of 5% or greater, Licensee shall also reimburse Licensor for the
reasonable cost of such audit in addition to other amounts due. In the event of a dispute related to a
Non-Compliance, Licensor shall have the right to collect from Licensee its reasonable costs and
attorneys' fees incurred in enforcing this Agreement.

14.RELATED SERVICES. Licensee shall be responsible for obtaining and installing all proper hardware
and other third party support software (including operating systems) for the proper installation and
implementation of the Licensed Software. In the event that Licensee retains Licensor to perform any
services with respect to the Licensed Software (for example: installation, implementation, maintenance,
consulting, or training services), Licensee and Licensor agree that such services shall be provided at
Licensor’s then- current standard terms, conditions, and rates for such services unless otherwise
agreed in writing by Licensor.

15.PRIVACY AND USE OF LICENSEE INFORMATION.

A. Responsibility and Compliance with Laws. Licensee is solely responsible for and assumes all liability
with respect to its own collection, processing, storage, and transfer of any user data, including, but not
limited to, personally identifiable information and personal health and financial information (collectively,
“Personal Information”). Licensee shall be solely responsible for notifying its users of proper use of such
data. Each party is responsible for complying with its respective obligations under all applicable laws,
regulations, and industry standards regarding data collection and data privacy applicable for the use of
the Licensed Software by the relevant party. Licensee shall not provide any Personal Information to
Licensor for processing by Licensor on behalf of Licensee, unless otherwise agreed by the parties in
writing in an applicable transaction document with applicable privacy terms. If the parties agree that
processing Personal Information is necessary for the performance of this specific transaction, and when
such Personal Information processing falls within the scope of the General Data Protection Regulation
(EU) 2016/679 (“GDPR”), before any Personal Information is made available to Licensor, the parties
agree that Licensee will be the data controller and Licensor will be the data processor, and when
Licensor is processing Personal Information on behalf of Licensee, such processing shall be governed
by terms that comply with Article 28 of the GDPR including standard contractual clauses to be included
in such transaction document. Licensor will not have access to protected health information unless the
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parties have an executed business associate agreement in place for this transaction. Licensee is solely
responsible for assessing the Licensed Product or any related product or service for compliance with
any industry requirements applicable to Licensee.

B. Consent to Use of Licensee Information. To the extent required or permitted by law, Licensee hereby
expressly consents to (i) receiving information from Licensor from time to time advertising Licensor’s
products; (ii) the use of Licensee’s name in Licensor customer lists, promotional materials, and press
releases; and (iii) the collection and use of information about the computer system on which the
Licensed Software is installed (e.g. product version, serial number) for internal security and licensing
purposes. Further information about Licensor’s processing of personally identifiable data is available at 
https://www.microfocus.com/about/legal/#privacy (click “Privacy Notice” tab) or can be provided by
Licensor at Licensee’s request.

C. Other Use of Licensee Information. To the extent required or permitted by law, and notwithstanding
the terms in Section 15.A, Licensor may also process personally identifiable information of Licensee
and Licensee’s users (i) in order to comply with a legal obligation to which Licensor is subject; (ii) as is
necessary for the performance of this Agreement; and (iii) where necessary for the purposes of
Licensor’s legitimate interests, except where such interests are overridden by the interests or
fundamental rights and freedoms of the Licensee or Licensee’s users which require protection of
personally identifiable information.

16.LICENSEE TRADEMARK AND FEEDBACK. Licensor may use Licensee’s name and logo for business
development and marketing purposes, including, but not limited to, online and printed sales and
marketing materials. Any other use of Licensee’s name or logo, or a description of Licensee’s use of the
Licensed Software, shall be subject to Licensee’s prior consent. Any suggestions, ideas for
modifications, enhancements, and other feedback from Licensee regarding the Licensed Software
provided at any time (collectively, the “Feedback”), including (but not limited to) all intellectual property
rights in and to such Feedback, shall be owned exclusively by Licensor. Licensee hereby assigns all
right, title and interest in and to such Feedback and all the intellectual property rights therein to
Licensor, without the necessity of any further consideration. To the extent any Feedback cannot be
assigned to Licensor, Licensee hereby grants to Licensor a perpetual, irrevocable, exclusive, worldwide,
royalty-free, fully paid up license, with the right to sublicense through multiple tiers to use, make, sell,
distribute, execute, adapt, translate, reproduce, display, perform, modify, create derivative works of and
otherwise exploit the Feedback in any manner.

17.MISCELLANEOUS.

A. Assignment. Licensor may assign this Agreement, including any rights or obligations under the
Agreement (in whole or in part) to a parent or an affiliate. Licensee may not assign or transfer this
Agreement or any of its rights or duties hereunder, including (but not limited to) by merger, acquisition
by any entity of all or substantially all of Licensee’s stock or assets, change of control, operation of law,
or otherwise, without the prior written consent of Licensor and payment by Licensee of the applicable
assignment fee. Any attempted assignment not in accordance with this Section shall be null and void.

B. Governing Law. If Licensee is located in North America, the laws of the State of California govern this
Agreement and the licenses granted hereunder, and the parties hereto consent to the exclusive
jurisdiction of the State and Federal courts of the State of California in any action based on this
Agreement or the Licensed Software hereunder or any License Option under an ALA. Each party
waives any right it may have to object to such venue, including objections based on personal jurisdiction
or forum non conveniens (inconvenient forum). The parties agree that the Uniform Computer
Information Transaction Act or any version thereof, adopted by any state, in any form ("UCITA"), shall
not apply to this Agreement. To the extent that UCITA is applicable, the parties hereby opt out of the
applicability of UCITA pursuant to the opt-out provision(s) contained therein. If Licensee is located in
France, Germany or Japan, this Agreement is governed by the laws of the country in which Licensee is
located. In the rest of the world the laws of England govern this Agreement. In each case, the applicable
law shall apply without regard to conflict of laws provisions thereof, and without regard to the United
Nations Convention on the International Sale of Goods. Other than for North American transactions, this
Agreement, the licenses granted hereunder, and the parties hereto, shall be subject to the exclusive
jurisdiction of the courts of the country determining the applicable law as aforesaid.
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C. Export Control. This Agreement may be subject to export control laws, regulations, and other
restrictions of the United States (including, but not limited to, the U.S. Export Administration Regulations
(the “EAR”)), United Kingdom, or the European Union regarding export or re-export of computer
software and technology. Licensee agrees to comply with all applicable export control laws, regulations,
and restrictions, including the EAR, where applicable.

D. Entire Agreement. The applicable Product Order and this Agreement including the applicable ALA,
constitutes the complete and exclusive statement of agreement between the parties relating to the
license for the Licensed Products and supersedes all prior proposals, communications, purchase
orders, and agreements (including, without limitation, Other Agreements), without need for a mutually
executed amendment to any such Other Agreement. Any conflicting terms and conditions shall be
resolved according to the following order of precedence: the applicable Product Order, the applicable
ALA, and then this Agreement in all other respects.

E. Amendment. No representation, supplement, modification, or amendment of this Agreement will be
binding on either party unless executed in writing by duly authorized representatives of both parties
(excluding any distributor or reseller of Micro Focus) to this Agreement.

F. Waiver. No waiver of any right under this Agreement will be effective unless in writing and signed by
authorized representatives of both parties (excluding any distributor or reseller of Licensor). No waiver
of any past or present right arising from any breach or failure to perform will be deemed to be a waiver
of any future right arising under this Agreement.

G. Severability. If any provision in this Agreement is invalid or unenforceable, that provision will be
construed, limited, modified or, if necessary, severed, to the extent necessary, to eliminate its invalidity
or unenforceability, and the other provisions of this Agreement will remain unaffected.

H. No Reliance. Each party acknowledges that in entering into this Agreement it has not relied on any
representations, agreements, warranties or other assurances (other than those repeated in this
Agreement) and waives all rights and remedies which but for this Section 17 would be available to it.

Micro Focus EULA (1 November 2019)
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